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CONSIGNES DE SÉCURITÉ IMPORTANTES

ATTENTION — POUR VOTRE 
PROTECTION, LISEZ CE QUI SUIT :

CONSERVEZ CES INSTRUCTIONS

TENEZ-COMPTE DE TOUTE LES MISES EN GARDE

RESPECTEZ TOUTES LES CONSIGNES

L’APPAREIL NE DOIT PAS ÊTRE EXPOSÉ À L’HUMIDITÉ ET AUCUN OBJET 
CONTENANT DU LIQUIDE, COMME UN VASE, NE DOIT ÊTRE  PLACÉ 
SUR L’APPAREIL.

NETTOYEZ UNIQUEMENT A L’AIDE D’UN TISSU SEC.

NE BLOQUEZ PAS LES OUïES DE VENTILATION. INSTALLEZ L’APPAREIL 
EN SUIVANT LES CONSIGNES DU FABRICANT.

N’INSTALLEZ PAS L’APPAREIL PRÈS D’UNE SOURCE DE CHALEUR 
COMME UN RADIATEUR, UN FOUR OU AUTRE APPAREIL DÉGAGEANT 
DE LA CHALEUR (Y COMPRIS LES AMPLIS DE PUISSANCE).

N’UTILISEZ QUE DES ACCESSOIRES ET FIXATIONS  RECOMMANDÉS PAR 
LE CONSTRUCTEUR.

DÉCONNECTEZ CET APPAREIL DU SECTEUR PENDANT LES ORAGES OU 
LORS DE LONGUES PÉRIODES D’INUTILISATION.

Ne supprimez jamais la mise à la terre ou le repérage de polarisation des 
prises de terre (Canada). Les prises polarisées possèdent deux broches dont 
une plus large que l’autre. Une prise avec terre possède deux contacts plus 
une mise à la terre. La broche la plus large ou la troisième broche de mise 
à la terre sont là pour votre sécurité. Si la fiche fournie ne correspond pas 
à votre installation électrique, faites appel à un électricien pour effectuer 
les modifications.

Protégez le cordon d’alimentation afin qu’on ne puisse pas marcher 
dessus ni le pincer, particulièrement à l’endroit des prises et des rallonges 
électriques, ainsi qu’à la sortie de l’appareil.

Utilisez uniquement un chariot, un trépied ou un diable ou une table 
recommandé par le fabricant ou vendu avec l’appareils. Soyez très prudent 
lorsque vous utilisez un chariot et évitez tout accident ou blessure possible 
liée à la chute de l’appareil et du chariot.  
Les travaux d’entretien de l’appareil doivent être effectués par un 
personnel qualifié. Une révision de l’appareil est nécessaire si l’appareil a 
été endommagé de quelle  manière que ce soit, comme lorsque le cordon 
d’alimentation ou la fiche secteur sont  endommagés, si du liquide ou un 
objet a pénétré à l’intérieur du boîtier, si l’appareil a été exposé à la pluie 
ou l’humidité, ne fonctionne pas correctement ou à la suite d’une chute.

INTERRUPTEUR SECTEUR : Pour les produits équipés d’un interrupteur, 
l’interrupteur  ne DÉCOUPLE PAS l’appareil totalement du secteur.

DÉCONNEXION DU SECTEUR : La fiche secteur doit rester accessible à tout 
moment. Pour les installations en Rack ou pour les installations où la fiche 
secteur n’est pas accessible, installez un interrupteur secteur multi-polaire 
avec une séparation entre les bornes d’au moins 3 mm.

APPAREIL AVEC FUSIBLE EXTERNE : Remplacez par un autre exactement 
identique.

APPAREIL À TENSION, SECTEUR MULTIPLE : Ce appareil peut nécessiter 
un cordon secteur répondant à d’autres normes et formats électriques selon 
le pays d’utilisation. Connectez cet appareil uniquement à une tension sec-
teur dont les caractéristiques sont indiquées à l’arrière de l’appareil. Pour 
éviter tout risque d’électrocution, confiez toutes les opérations d’entretien 
à un personnel qualifié.

CONSIGNES DE SÉCURITÉ

POUR LES UtiLiSAtEURS DONt LES ÉqUiPEmENtS SONt mUNiS D’UN 
CORDON SECtEUR.

AttENtiON : CEt APPAREiL DOit ÊtRE CONNECtÉ À UNE PRiSE SECtEUR 
AVEC tERRE.

Les fils de la fiche secteur sont repérés par couleurs : 

VERT et JAUNE - Terre  BLEU - Neutre   MARRON - Phase

Si les couleurs des fils de vos prises électriques sont différentes de celles du 
cordon secteur de notre produit, procédez comme suit : 

•  Le fil jaune et vert doit être connecté à la borne E (Earth, ou terre), 
ou à la borne avec le symbole de la terre, ou la borne verte, ou à la 
borne jaune et vert. 

•  Le fil bleu doit être connecté à la borne N ou noire.
•  La phase doit être reliée à la borne L ou repérée en rouge.

 
Cet appareil peut nécessiter un cordon et/ou une fiche secteur différent. 
Consultez un électricien et demande-lui de consulter le tableau ci-dessous. 
Le fil vert/jaune doit être connecté au boîtier de l’appareil.

CONDUCTEUR COULEUR
Normal Autre

L PHASE MARRON NOIR

N NEUTRE BLEU BLANC

E TERRE
VERT/
JAUNE

VERT

MISE EN GARDE : Si la mise à la terre est désactivée, vous 
risquez de graves risques d’électrocution avec des possibilités de tension 
secteur portée entre la terre et le boîtier de l’appareil lui-même. Cette 
condition peut entraîner la mort. 

Les symboles représentés ci-dessus sont admis sur le plan international 
comme des mises en garde contre les risques électriques. L’éclair terminé 
par une flèche dans un triangle équilatéral signifie que le produit contient 
des tensions électriques dangereuses. Le point d’exclamation dans un 
triangle équilatéral indique que l’utilisateur doit se rapporter au mode 
d’emploi.

Ces symboles avertissent que le produit ne contient aucune pièce réparable 
par l’utilisateur. N’ouvrez pas le produit. N’essayez pas de réparer le pro-
duit vous-même. Faites effectuer les réparations par un personnel qualifié. 
L’ouverture du châssis pour quelle raison que ce soit annule la garantie du 
constructeur. N’exposez pas le produit à l’humidité. Si du liquide a été 
répandu sur le produit, éteignez l’appareil immédiatement et portez-le 
chez le revendeur pour réparation. Déconnectez le produit lors des orages 
afin d’éviter de possibles dégâts.
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DÉCLARATION DE CONFORMITÉ
Nom du fabricant :   Lexicon®

Adresse du fabricant :  8760 S. Sandy Parkway
    Sandy, Utah 84070, USA

déclare que le produit :

Nom du produit :   i•ONiX U22S
Remarque : Le nom du produit peut être précédé par la désignation "EU". 

Options du produit :   Aucune

Ce produit est conforme aux normes suivantes :

 Sécurité :   iEC 60065-01 + Amd. 1
    
 EmC :   EN 55013 (2001 + A1)
    EN 55020 (1998)

informations supplémentaires :

Ce produit est conforme aux normes sur les produits à basse tension 2006/95/EC et EmC 
2004/108/EC.
  
  Le Vice Président
  8760 S. Sandy Parkway     
  Sandy, Utah 84070, USA
  Date : 16 mars 2009

Contact en Europe : Votre filiale locale ou votre point de vente ou de réparation Lexicon, ou

   Harman music Group
   8760 South Sandy Parkway
   Sandy, Utah  84070,  USA
   tél : (801) 566-8800
   Fax : (801) 566-7005

Si vous souhaitez vous débarasser de ce produit, ne le jetez pas avec les autres ordures ménagères.  
Le ramassage des équipements électroniques se fait séparément pour assurer le recyclage correct
de ces équipements.

Les citoyens des 25 états membres de la CEE, les Suisses et les Norvégiens peuvent apporter leurs produits
électroniques sans frais dans le centre de recyclage le plus proche ou auprès de leur revendeur (dans le cas de
l’achat d’un produit similiare).

Pour les membres des autres pays, consultez les autorités locales.

En agissant ainsi de façon responsable, les produits sont recyclés de façon convenable, ce qui aide à protéger notre
environnement et évite tout effet négatif potentiel sur notre santé.

COMPATIBILITÉ  
ÉLECTROMAGNÉTIQUE 

Ce produit est conforme aux caractéristiques de fabrication 
indiquées sur la déclaration de conformité. Son fonc-
tionnement est soumis aux deux conditions suivantes :

cet appareil ne doit causer aucune interférence •	
dangereuse, et
cet appareil•	  doit accepter toutes les interférences, 
y compris les interférences pouvant causer des 
dysfonctionnements.
Le fonctionnement de cet appareil à l’intérieur de •	
champs magnétiques importants doit être évité.
utilisez uniquement des câbles blindés.•	



Informations sur les réparations
Pour toute information technique, contactez le service clientèle de Lexicon®, votre reven-
deur, ou votre distributeur. 
Vous devrez décrire en détail le problème. Préparez le numéro de série de l'appareil, situé 
sur un autocollant placé sous l'I-ONIX 22. Prenez le temps de remplir la carte de garan-
tie et renvoyez-la.

Avant de nous renvoyer le produit, consultez le mode d'emploi. Veillez suivre les étapes 
d'installation et les procédures d'utilisation. Si vous n'arrivez toujours pas à résoudre 
le problème, contactez notre Service Clientèle au (801) 568-7660. Si vous devez nous 
renvoyer le produit, vous DEVEZ au préalable contacter le Service Clientèle pour obte-
nir un numéro d'autorisation pour le retour du produit. Nous n'accepterons aucun 
produit sans numéro d'autorisation préalable. Consultez les informations de garantie. 
Une fois la garantie terminée, nous facturerons un prix raisonnable pour les pièces, la 
main d'œuvre, et les frais d'emballage et de manutention, si vous souhaitez faire réparer 
l'appareil en usine. Dans tous les cas, vous êtes responsable des frais de port jusqu'à nos 
usines. Lexicon Professional prend en charge les frais de retour lorsque le produit est 
sous garantie. 

Utilisez l'emballage original pour le retour. Inscrivez le nom du transporteur sur le 
paquet et écrivez en rouge : INSTRUMENT FRAGILE ! Assurez le transport avec une 
valeur correcte. Vous devez payer les frais de retour par avance auprès du transporteur. 
N'envoyez pas par la poste.

Garantie
Les conditions de garantie peuvent varier d'un pays à un autre, d'une région à une 
autre, d'une province à une autre, etc. 

Consultez votre revendeur ou votre distributeur pour connaître des conditions de garan-
tie qui vous sont propres. Notez les points suivants :

 Vous devez renvoyer la carte de garantie fournie avec le produit (vous pouvez éga-1. 
lement vous enregistrer en ligne à l'adresse www.lexiconpro.com) dans les 30 jours 
suivant l'achat du produit pour activer la garantie. Le consommateur est responsa-
ble de la fourniture de la preuve d'achat. 
 Selon les termes de la garantie, la responsabilité de Lexicon Professional se limite 2. 
à la réparation (ou à notre discrétion, au remplacement) des éléments défectueux, 
dans la mesure où le produit est renvoyé à Lexicon Professional AVEC UNE 
AUTORISATION DE RETOUR délivrée par nos usines. Toutes les pièces et la 
main d'œuvre sont couverts pendant une période d'1 an. Vous pouvez obtenir un 
numéro de retour auprès de Lexicon Professional par téléphone. La société ne peut 
être tenue responsable de dommages directs ou indirects liés à l'utilisation du pro-
duit.
 Lexicon Professional se réserve le droit d'apporter des modifications dans la 3. 
conception ou l'apparence du produit sans obligation d'apporter ces modifications 
aux produits déjà fabriqués.
 La société Lexicon Professional, ses filiales, distributeurs ou revendeurs ne peuvent 4. 
être tenus responsables des dommages directs ou indirects liés à l'utilisation du 
produit.
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Introduction
Merci d'avoir choisi cette interface d'enregistrement Lexicon® I•ONIX U22. 

Le système breveté I•ONIX U22 s'insère parfaitement entre votre clavier et 
votre écran. Avec tous les niveaux d'écoute et d'entrée au bout de vos doigts, 
vous vous demanderez comment vous avez fait jusqu'à aujourd'hui. 
 
Équipé de nos nouveaux préamplis micro à haute tension dbx® 60 V, à 
ultra-faible bruit de fond sur chaque canal, l'I·ONIX U22 vous garantit des 
enregistrements de qualité professionnelle avec une musique toujours de la 
plus haute qualité. Les préamplis sont alimentés par une haute tension de 
60 Volts pour vous garantir une stabilité totale, une qualité d'enregistrement 
inégalée et une plage dynamique très élevée. Les convertisseurs A/N et N/A 
hautes performances travaillent en 24 Bits à 96 kHz et capturent avec subti-
lité chaque détail de vos enregistrements.

Le nom de Lexicon est synonyme de “meilleures réverbérations au monde”. Le 
Plug-In VST/AU de réverbération Pantheon™ II vous offre 6 types de réver-
bérations avec 16 paramètres réglables, et 35 Presets d'usine allant des chants 
de studio aux réverbérations de scène en passant par les effets spéciaux. Il vous 
est facile d'apporter cette touche de finition ultime à votre musique grâce à ces 
réverbérations soyeuses et riches qui ont fait la renommée de Lexicon.

Généralités
Connexion USB 2.0 à votre application de MAO — jusqu'à 480 Mo/s• 
Fréquence d'échantillonnage de 44,1 à 96 kHz, en 24 bits• 
Deux embases analogiques combinées Jack 6,35 mm et XLR en face arriè-• 
re sur les entrées micro/ligne

Entrées latérales à haute impédance pour instruments en Jacks 6,35 mm• 
Sorties analogiques en Jack stéréo 6,35 mm (sorties stéréo) • 
Préamplis micro haute tension 60 Volts dbx• ® à bruit de fond ultra faible 
sur toutes les entrées micro/ligne analogiques

Compatible Windows® et Mac®• 
Alimentation fantôme 48 V sur chaque paire d'entrées• 
Affichage du niveau d'entrée par 8 Leds par canal • 
Affichage du niveau de mixage et du niveau de bus stéréo• 
Sortie casque 6,35 mm à niveau de sortie élevé• 
MIDI In/Out• 
Écoute exempte de toute latence• 
Pilotes ASIO à faible latence• 
Plug-In de réverbération VST/AU Lexicon Pantheon II • 
La suite logicielle comprend Cubase• ® LE 4 de Steinberg®, et Toontrack® 
EZdrummer® Lite
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Découverte de votre interfaceI•ONIX U22
Les interfaces d'enregistrement I•ONIX U22 sont expédiées dans un carton 
unique, contenant le boîtier U22 et un DVD de logiciels pour Windows® 
et Macintosh®. Après déballage, conservez les produits d'emballage au cas 
où vous devriez les utiliser à nouveau. Inspectez avec soin l'I-ONIX U22S 
et l'emballage pour tout signe de dommage. Rapportez immédiatement les 
dommages liés au transport auprès du transporteur ou du vendeur auprès 
duquel vous avez acheté le produit.

ÉLÉMENTS FOURNIS :
U22• 
Le DVD d'installation avec les pilotes, le Plug-in de réverbération • 
Lexicon Pantheon II, l'application de MAO Cubase LE 4, et l'ap-
plication de rythmes ToonTrack® EZ Drummer Lite pour Mac® et 
Windows® 
Le câble USB• 
Carte de garantie Lexicon Professional• 
L'adaptateur secteur• 

REMARQUE : Le mode d'emploi complet de Cubase LE 4 est également 
situé sur le DVD.

Systèmes requis
Les applications audionumériques puissantes nécessitent des configura-
tions informatiques puissantes avec le système d'exploitation adapté, un 
processeur rapide et une mémoire importante. La plupart des ordinateurs 
disponibles sur le marché de nos jours semblent répondre à ces exigences ou 
peuvent être aisément mis à jour pour être compatibles avec l'I•ONIX U22. 
Comme toujours, l'ajout de mémoire RAM supplémentaire par rapport aux 
exigences minimales vous offrira une puissance de traitement accrue et des 
performances globales améliorées.   

Windows® Vista, XP 
Système multi-coeur• 
1 Go de RAM (recommandé)• 
Résolution d'affichage de 1024 x 768 pixels• 
Lecteur de DVD-ROM• 
Accès Internet pour l'activation de la licence• 

Mac®

Système multi-coeur Intel• ®

1 Go de RAM (recommandé)• 
OS X Version 10.4.9 ou plus récente• 
Résolution d'affichage de 1024 x 768 pixels• 
Lecteur de DVD-ROM• 
Accès Internet pour l'activation de la licence• 

Remarque : Adobe Reader est nécessaire pour afficher les documents .pdf 
contenus sur le DVD.
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Face avant
1 2

3 4 5 6 7 8 9 10 11

1. LEDS DE NIVEAU D'ENTRÉE
Elles indiquent le niveau du signal de chaque entrée en indiquant la réserve 
dynamique avant écrêtage. Les valeurs sont :
Rouge  Écrêtage
Jaune  –3 dB
Vert  –6 dB
Vert  –9 dB
Vert  –12 dB
Vert  –18 dB
Vert  –24 dB
Vert  –30 dB

2. LEDS DE NIVEAU DE SORTIE
Elles indiquent le niveau du signal de chaque sortie en indiquant la réserve 
dynamique avant écrêtage. Les valeurs sont :
Rouge  Écrêtage
Jaune  –3 dB
Vert  –6 dB
Vert  –9 dB
Vert  –12 dB
Vert  –18 dB
Vert  –24 dB
Vert  –30 dB

3. BOUTON DE NIVEAU PhONES
Règle le niveau de la sortie casque. 

4. BOUTON DE GAIN MIC/LINE/INST 1
Détermine le gain de l'entrée Mic/Line 1 ou Instrument. 
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5. LED INSTRUMENT
S'allume lorsqu'un Jack 6,35 mm est inséré dans l'embase Instrument du 
panneau latéral droit.

6. TOUChE STÉRÉO ET LED STÉRÉO
Cette touche vous permet de configurer l'entrée Mic/Line 1 (ou Instrument) 
en stéréo ou mono. La Led s'allume en mode stéréo. 
 
En mode stéréo (Led Stereo allumée), les signaux des entrées  
Instrument et Mic/Line 1 sont dirigés vers la sortie gauche Left Main Out, et 
les signaux des entrées Mic/Line 2 vers la sortie droite Right Main Out.  
 
En mode Mono mode (Led Stereo éteinte), chaque paire d'entrées est 
mélangée et dirigée vers les sorties Main Outs Left et Right sous la forme 
d'uns signal mono. Une paire comprend l'entrée Instrument ou Mic/ 
Line 1 et Mic Line 2. 

Ceci n'affecte pas le signal transmis à l'ordinateur.

7. LED 48V
S'allume lorsque l'alimentation fantôme est active pour la paire d'entrées 
Mic/Line 1 et 2. Vous pouvez activer/désactiver l'alimentation fantôme 
par paires d'embases d'entrées combinées grâce aux touches 48V de la face 
arrière. Les micros dynamiques n'ont pas besoin d'être alimentés. Ceci dit, 
l'alimentation fantôme ne leur pose aucun risque de dommage. La plupart des 
micros à condensateur ont besoin de l'alimentation fantôme pour fonction-
ner. En cas de doute, consultez le mode d'emploi du micro ou contactez votre 
revendeur. 

8. BOUTON DE GAIN MIC/LINE 2
Ce bouton règle le gain de l'entrée Mic/Line 2. 

9. BOUTON OUTPUT LEVEL
Ce bouton règle le niveau des sorties générales gauche et droite.

10. BOUTON MONITOR MIx
L'I•ONIX U22 vous permet d'écouter directement vos entrées analogiques 
pendant l'enregistrement, sans avoir à régler les niveaux dans le logiciel, 
et avant les temps de retard causés par les convertisseurs numériques et la 
latence d'enregistrement de l'ordinateur. Cette écoute analogique exempte 
de latence est contrôlée par le bouton Monitor Mix, que vous pouvez utiliser 
pour régler le dosage entre les entrées analogiques (“directes”) et les signaux 
de votre ordinateur par USB (“lecture”). Pour régler le niveau de la lecture en 
provenance de l'ordinateur (pistes précédentes, retours d'effets, etc.), utilisez 
les Faders de l'écran du mélangeur du logiciel. Pour écouter uniquement les 
sources d'entrées directes connectées à l'U22, réglez le bouton Mix au mini-
mum, en position Direct. Pour écouter uniquement le mixage en provenance 
de l'ordinateur, placez le bouton Mix complètement à droite, sur Playback. 
Les signaux en provenance de l'entrée S/PDIF sont convertis en analogique 
et transmis au bouton de Mix, ce qui vous permet d'écouter directement 
cette entrée, comme c'est le cas avec les entrées analogiques. La sortie du 
bouton Monitor Mix est dirigée vers les sorties Line et Headphone. 

11. LED USB
S'allume lorsqu'une connexion USB est détectée.
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Faces arrière et latérales

1 2 3 4 5 6 7 8

1. ENTRÉE INSTRUMENT
Cette entrée asymétrique accepte les fiches Jack 6,35 mm et les signaux à 
niveau instrument (dont les guitares). Notez que lorsque l'entrée Instrument 
est utilisée, l'entrée Mic/Line 1 est désactivée. 

2. EMBASE POwER
Utilisez uniquement l'adaptateur secteur PSS3-xxx fourni ("xxx" correspond 
à la tension secteur).

3. PORT USB
Le port USB permet de connecter l'U22à votre ordinateur. Nous vous four-
nissons un câble USB standard. L'U22 est compatible USB 2.0 uniquement.

4. MIDI IN ET MIDI OUT
Les embases MIDI IN et OUT vous permettent la connexion à votre ordina-
teur, vos claviers MIDI, vos expandeurs, et vos contrôleurs externes.

5. SORTIES GÉNÉRALES MAIN OUTPUTS
Ces sorties fournissent des liaisons symétriques (Jacks 6,35 mm stéréo) ou 
asymétriques (Jacks 6,35 mm mono). Utilisez-les pour la connexion à une 
console de mixage, un amplificateur de puissance, des moniteurs actifs, 
un enregistreur, ou tout autre équipement à niveau ligne. Pour obtenir les 
meilleurs résultats sonores, utilisez des connexions symétriques.

6. ENTRÉES MIC/LINE INPUTS 1–2
Ces entrées symétriques acceptent des fiches XLR ou Jack 6,35 mm, et des 
signaux à niveau micro et ligne. Notez que lorsque l'entrée Instrument est 
utilisée, l'entrée Mic/Line 1 est désactivée.  

7. TOUChE FANTôME 48V - MIC/LINE 1 ET MIC/LINE 2
Active l'alimentation fantôme des entrées Mic/Line 1 et Mic/Line 2. 
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Lorsque l'alimentation est activée la Led +48V entre les boutons de gain 
Mic/Line/Inst 1 et 2 de la face avant s'allume. Les micros dynamiques n'ont 
pas besoin d'être alimentés. Ceci dit, l'alimentation fantôme ne leur pose 
aucun risque de dommage. La plupart des micros à condensateur ont besoin 
de l'alimentation fantôme pour fonctionner. En cas de doute, consultez le 
mode d'emploi du micro ou contactez votre revendeur. Laissez cette touche 
en position DÉSACTIVÉE si vous utilisez des signaux à niveau ligne dans 
les entrées Mic 

8. JACk hEADPhONE
Cette sortie permet la connexion d'un casque avec fiche Jack stéréo 
6,35 mm. Cette sortie transmet le même signal que celui des sorties généra-
les Main, et possède son propre réglage de niveau de sortie. 
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Connexion de l'I•ONIx U22
Micros
Connectez un câble XLR directement entre le micro et l'entrée Mic/Inst en 
face arrière de l'U22.  

Si le micro doit être alimenté par fantôme, connectez le micro puis appuyez 
sur la touche +48V au-dessus des entrées. Si le micro n'utilise pas l'alimenta-
tion fantôme laissez la touche relâchée.

Remarque : Certains micros peuvent être endommagés par la présence de la 
tension fantôme 48 Vcc. Consultez le mode d'emploi de votre micro avant 
d'activer l'alimentation fantôme 48 Vcc.

Sources à niveau ligne
Les sources à niveau ligne regroupent les claviers, les boîtes à rythmes, les 
lecteurs de CD, les préamplis micro extérieurs et les effets. Connectez un 
câble en Jacks 6,35 mm mono (asymétrique) ou stéréo (symétrique) direc-
tement entre la source à niveau ligne et l'entrée Mic/Inst de l'U22, en face 
arrière. Pour obtenir un bruit de fond aussi faible que possible, utilisez des 
connexions symétriques à niveau ligne.

Instruments
Le Jack Instrument du panneau latéral accepte les signaux d'instruments 
comme une guitare ou une basse électrique. Connectez un câble Jack 
6,35 mm directement entre l'instrument et l'entrée Instrument du panneau 
latéral droit de l'U22. Notez que lorsque l'entrée Instrument est utilisée, 
l'entrée Mic/Line 1 est désactivée.

Le Jack Instrument sur le côté droit accepte les signaux des instruments 
comme les guitares et les basses électriques. Connectez un câble instrument 
en Jacks mono 6,35 mm (liaison asymétrique) directement entre l'instrument 
et l'entrée Instrument sur le côté droit du U22. Notez que lorsque l'entrée 
Instrument est utilisée, l'entrée Mic/Line 1 est désactivée.

Ordinateur/Station d'enregistrement audionumérique
Connectez le port USB de votre ordinateur au port USB à l'arrière de l'U22 
à l'aide du câble USB standard fourni.

Casques
Connectez le casque à la sortie Headphones du panneau latéral gauche. 
L'embase casque est au format Jack stéréo 6,35 mm. Réglez le volume du 
casque avec les boutons Phones Level.

Moniteurs
Utilisez des câbles en Jacks 6,35 mm entre les sorties L/R Main Out de la 
face arrière et les entrées de votre console de mixage, amplis de puissance, ou 
moniteurs actifs (amplifiés). Réglez le niveau de sortie avec le bouton Output 
Level. Pour obtenir les meilleurs résultats sonores, utilisez des câbles symétri-
ques.
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Câble USB 

Micro

PC ou Mac 

Écran

Sortie
casque

Casque

Enceintes actives

Clavier

Câble instrument en Jacks 6,35 mm

Exemples de connexions



9 

U22 — Exemple : Enregistrer une guitare
Suivez les étapes de cet exemple pour commencer à vous familiariser avec 
l'U22. Cet exemple utilise Cubase® LE 4, mais l'U22 fonctionne avec toutes 
les applications de MAO.

Installation des pilotes, de l'application de gestion, et 
de Cubase® LE 4 

Insérez le DVD dans votre lecteur de DVD-ROM. L'application d'ins-1. 
tallation démarre automatiquement.  
 
Si l'installeur ne se lance pas automatiquement, lancez-le manuellement 
en ouvrant le fichier correspondant sur le DVD : 
 
Mac® :   Cliquez sur  Open Me 
Windows® :  Lancez le fichier Menu.exe 

Une fois l'installeur ouvert, suivez les instructions à l'écran pour instal-2. 
ler le logiciel.  
 
Remarque : Vous devez installer les pilotes de l'I-ONIX U22 pour uti-
liser l'U22 avec Cubase® LE 4. Vous devez également installer Cubase 
LE 4 pour suivre les étapes du projet d'exemple dans les pages suivan-
tes.  
 
Vous trouverez les derniers pilotes sur le site www.lexiconpro.com. 

Activez Cubase LE 4
 Installez Cubase LE 4.1. 
 Lancez Cubase LE 4 et cliquez sur Register Now (enregistrer mainte-2. 
nant) ou allez sur le site www.steinberg.net/en/mysteinberg

 Créez un compte MySteinberg (suivez les instructions à l'écran) et 3. 
connectez-vous à votre compte MySteinberg.

 Cliquez sur Cubase LE 4 dans la section Activation & Reactivation puis 4. 
clilquez sur More (plus) dans la section Permanent Activation.

 Saisissez votre numéro de licence logicielle Soft-eLicense (Sel Nr.). Pour 5. 
trouver ce numéro :  
Windows : Démarrer > Tous Programes > Syncrosoft > Centre de ges-
tion des licences.   
Mac : Applications > Centre de gestion des licences.

 Sélectionnez Lexicon dans le champ des fabricants (Hardware 6. 
Manufacturer) et cliquez sur Request Activation Code (requête d'activa-
tion du code).  

 Copiez votre code d'activation.  7. 
 Revenez à la fenêtre du Centre de gestion des licences (où vous avez 8. 
trouvé votre licence eLicense) et cliquez sur Wizards (assistant) > License 
Download (téléchargement de la licence).

 Cliquez sur Next (suite) et copiez/collez ou saisissez manuellement le 9. 
code d'activation. Cliquez sur Enter, Next, puis sur Start (démarrer).
Une fois la licence téléchargée, cliquez sur OK puis sur Finish (termi-10. 
ner).

eLicense Number
(20 characters)

Activation code
(32 characters)
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Configuration audio et MIDI sous Windows® (optionnel)
Une fois les pilotes et le logiciel de gestion Control installés, Windows peut 
les avoir sélectionnés automatiquement comme vos sorties audio et MIDI 
par défaut. Cela signifie que vos sons système Windows seront envoyés à 
l'U22 à la place de la carte son de l'ordinateur. Vous devez regardez si l'ordi-
nateur à fait la modification, et, si c'est le cas, revenir aux réglages d'origine :

Sélectionnez 1. Démarrer>Panneau de Configuration>Périphériques Son 
et Audio (XP) ou Périphériques et Son (Vista).
Sélectionnez l'onglet 2. Audio (XP) ou Gestion des périphériques Audio 
(Vista).
Dans 3. Périphérique de lecture son>Défaut (XP), ou Lecture (Vista), 
vérifiez que la carte son de l'ordinateur soit sélectionnée comme périphé-
rique par défaut.
Dans les périphériques 4. Son Enregistrement>Défaut (XP), ou 
Enregistrement (Vista), vérifiez que la carte son de l'ordinateur soit 
sélectionnée comme périphérique par défaut.
Dans la section du périphérique MIDI 5. Lecture>Défaut, ouvrez le menu 
déroulant et vérifiez que Microsoft GS Wavetable Synth soit sélectionné 
comme périphérique par défaut (XP uniquement). 

Connexions pour notre exemple

Sortie
casque

CasqueCâble instrument en Jacks 6,35 mm

Câble USB 

PC ou Mac 

Écran
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Connectez la guitare
Réglez le bouton 1. Mic/Line/Inst 1 au minimum.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Bouton Mic/Line/Inst 1

 

Connectez la guitare à l'entrée Instrument sur le panneau latéral droit.
 
 
 
 
 
 
 
 
 
 
 
 
 
 Entrée Instrument 
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Connectez le casque
Réglez le bouton 2. Phones au minimum.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Bouton Phones
 

Connectez le casque à l'embase 3. Phones sur le panneau latéral gauche. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sortie Phones
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Connectez l'ordinateur
Reliez le port USB de votre ordinateur au port USB de l'I-ONIX U22 situé 
en face arrière, à l'aide du câble USB standard fourni. 

 

 

 
 
 
 

 

Câble USB 

PC ou Mac 
Écran

Écoute directe de l'entrée guitare
1. Placez le casque sur vos oreilles.
2. Réglez le bouton Monitor Mix en position centrale. Ceci vous permet 

d'écouter un mixage 50 % - 50 % du signal direct de l'U22 et des signaux 
en provenance de Cubase.

3. Jouez de la guitare.
4. Montez progressivement le niveau Phones 1 jusqu'à ce que vous obteniez 

le niveau d'écoute souhaité.
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Configuration de Cubase® LE 4 pour l'I•ONIX U22
(Windows®)
1. Vérifiez que le câble USB fourni soit connecté entre l'ordinateur et l'U22. 

Veillez à ce que l'U22 soit sous tension. 

2. Lacez Cubase® LE 4 (dans le menu Démarrer, dans Lexicon®).

3. Si la fenêtre suivante s'affiche, cliquez sur OK.

4. Une fois dans Cubase LE 4, allez dans Devices>Device Setup.

5. Dans le menu Devices, cliquez sur VST Audio System et sélectionnez 
Lexicon I-ONIX U22 dans le menu déroulant des pilotes ASIO s'il n'est 
pas déjà sélectionné. Cliquez sur Switch pour changer de pilote, puis 
cliquez sur OK dans la fenêtre Device Setup. Vous êtes prêt à enregistrer 
avec l'U22 dans Cubase LE 4.

 

Remarque : Dans de nombreux cas, vous pouvez améliorer les performan-
ces en sélectionnant une latence plus importante dans le menu déroulant 
des performances système du panneau de contrôle ASIO (Périphériques > 
Configuration du périphérique > Lexicon I-ONIX U22 > Panneau de confi-
guration > ASIO). 
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Configuration de Cubase® LE 4 pour l'I•ONIX U22
(Mac®)
1. Vérifiez que le câble USB fourni soit connecté entre l'ordinateur et l'U22. 

Veillez à ce que l'U22 soit sous tension. 

2. Ouvrez Cubase LE 4 (dans le dossier Applications), et ouvrez le menu 
Devices>Device Setup comme indiqué :

3. Cliquez sur VST Audio System et sélectionnez Lexicon I-ONIX U22 
comme pilote ASIO, si ça n'est pas déjà le cas. 

4. Cubase® LE 4 vous demande maintenant si vous souhaitez remplacer le 
pilote. Sélectionnez Switch, puis OK.

5. Veillez à ce que le pilote soit chargé en cliquant sur Reset. Cliquez ensuite 
sur OK.

Utilisateurs de Mac® OS 10.4.x uniquement : Après avoir sélectionné 
Lexicon X4 comme pilote ASIO, vérifiez que les entrées du périphérique 
soient actives. À cette fin, procédez comme suit :
 

Sélectionnez le menu 1. Device>VST Connections.
Lorsque la fenêtre des connexions VST s'affiche, cliquez sur l'onglet des 2. 
entrées Inputs.
La case sous la colonne du périphérique Audio peut indiquer “3. Not 
Connected”. Dans ce cas, cliquez sur cette case et sélectionnez Lexicon 
I-ONIX U22 pour activer les entrées de l'U22. 
Fermez la fenêtre des connexions VST.4. 

Vous pouvez maintenant passer à l'étape suivante et enregistrer avec Cubase 
LE 4.
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Enregistrement d'une piste dans Cubase® LE 4

Création d'un nouveau morceau
Dans Cubase, cliquez sur 1. File > New Project. La fenêtre New Project 
s'affiche.
Sélectionnez 2. Lexicon I-ONIX U22 Mono In et cliquez sur OK.
Sélectionnez un dossier de morceau et cliquez sur 3. Choose.
Ajoutez une piste mono en cliquant sur 4. Project -> Add Track -> Audio. 
Sélectionnez la configuration Mono et cliquez sur OK.
Dans la fenêtre 5. Audio 1, le bouton d'armement de l'enregistrement  
doit déjà être allumé en rouge. Sinon, cliquez dessus pour l'allumer. 

 

 

Dans la fenêtre 6. Audio 1, cliquez sur le bouton d'écoute d'entrée  pour 
l'éteindre. 

 

ASSUREZ-VOUS QUE LE 
BOUTON D'ARMEMENT DE 
L'ENREGISTREMENT SOIT 

ALLUMÉ

ASSUREZ-VOUS QUE LE 
BOUTON D'ÉCOUTE SOIT 

ÉTEINT
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Lancement de l'enregistrement
Cliquez sur la touche d'1. enregistrement dans la zone des touches de trans-
port de Cubase® LE 4. 
 
 
 
  

Jouez de la guitare. 2. 
Lorsque vous avez terminé appuyez sur la touche 3. Stop. 

   
 
 
  Touche Stop

Écoute de l'enregistrement
Dans Cubase, cliquez sur la touche de 1. retour à zéro.

  Touche de retour à zéro  

Réglez le bouton 2. Phones au minimum.
Placez le casque sur vos oreilles.3. 
Dans Cubase, cliquez sur la touche de 4. lecture. 

 
  

Touche de lecture

Dans l'U22, montez progressivement le bouton 5. Phones jusqu'à obtenir le 
niveau d'écoute souhaité.

Dès que vous ajoutez une piste à votre morceau Cubase, le champ de rou-
tage des entrées Input Routing passe par défaut sur l'entrée U22 In 1. Ceci 
dit, si vous connectez des instruments ou d'autres entrées à l'interface U22, 
vous devez modifier le routage d'entrée de la piste sur laquelle vous enre-
gistrez.  Consultez le tableau ci-dessous pour voir comment les entrées sont 
indiquées dans Cubase LE 4 par rapport aux entrées physiques de l'interface 
U22. 
 

Entrées de l'interface U22
Notation des entrées dans les 

pistes mono de Cubase LE 4 (en 
utilisant le modèle de morceau 

par défaut Lexicon® I-ONIX U22 
Mono In Project)

1 U22 In 1

2 U22 In 2

 

Touche d’enregistrement
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Mixage audio
Vous pouvez utiliser les fonctions de mixage audio de Cubase® LE 4 pour 
créer un fichier .wav à partir de votre morceau Cubase.  Le fichier .wav peut 
être gravé sur CD ou être lu par le lecteur audio de votre ordinateur.  Cubase 
LE 4 ne génère pas de fichiers mp3 — vous devez utiliser un autre logiciel 
pour convertir un fichier .wav en mp3. 
 
Pour mixer votre morceau, vous devez commencer par définir les Locators 
gauche et droit, notamment en utilisant le raccourci clavier [Ctrl] + [A] puis 
en appuyant sur [P]. Vous pouvez glisser les Locators.
 
Une fois les Locators en place, ouvez le menu File > Export > Audio 
mixdown. Cliquez sur ‘Choose’ et nommez le fichier dans la zone ‘File 
name:’. Sélectionnez l'emplacement de la sauvegarde du fichier .wav dans le 
champ ‘Look in’ et cliquez sur ‘Save’.  Vous devez tout d'abord sauvegarder le 
fichier sur le disque dur de votre ordinateur pour pouvoir le graver sur CD.  
 
Sélectionnez ensuite Wave File (.wav) dans le champ ‘File Format’, réglez la 
fréquence d'échantillonnage ‘Sample Rate’ sur 44,1 kHz, réglez la résolution 
‘Bit Depth’ sur 16 bits, et cliquez sur Export.
 
Options et fonctions de Cubase LE 4
Cubase LE 4 offre de nombreuses fonctions et options d'enregistrement, 
d'édition et de mixage audio.  Pour en savoir plus, consultez les sections 
‘Getting started’ et ‘Operation Manual’ sur Cubase LE 4, dans le menu  
Help > Documentation.

Utilisation de la réverbération Pantheon II dans Cubase LE 4
La réverbération Pantheon est configurable dans Cubase LE 4 de deux 
façons : en insertion sur une piste audio ou sur une voie d'effets.
 
Pour utiliser la réverbération Pantheon II en insertion sur une piste audio : 

Placez l'interface U22 sous tension et reliez-la à votre ordinateur (la 1. 
Pantheon II ne fonctionne que lorsque l'interface I•ONIX est détectée).
Cliquez sur l'onglet 2. Inserts de la voie sur laquelle vous souhaitez insérer 
la réverbération Pantheon II.
Cliquez dans la banque et sélectionnez 3. Earlier VST Plug-ins > Lexicon 
> Pantheon II. La réverbération Pantheon II est audible uniquement sur 
les voies sur lesquelles elle est insérée.

 
Pour utiliser la réverbération Pantheon II en insertion sur une voie d'effets : 

Placez l'interface U22 sous tension et reliez-la à votre ordinateur (la 1. 
Pantheon II ne fonctionne que lorsque l'interface I•ONIX est détectée).
Ajoutez une voie d'effets FX : allez dans 2. Project > Add track > FX 
Channel, et cliquez sur Inserts de la voie FX.  
Cliquez dans la banque et sélectionnez 3. Earlier VST Plug-ins > Lexicon 
> Pantheon II.  
Cliquez sur l'onglet 4. Sends des pistes audio sur lesquelles vous souhaitez 
ajouter de la réverbération.
Cliquez dans un emplacement vide et réglez la sortie sur 5. FX-1 Pantheon 
II.
Cliquez sur le bouton Marche et réglez le niveau de départ. N'importe 6. 
quelle piste peut bénéficier de l'effet défini sur la voie d'effets FX.
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Caractéristiques techniques

Les ingénieurs de Lexicon® cherchent en permanence à améliorer la qualité de nos produits. Les carac-
téristiques sont par conséquent sujettes à modifications sans préavis.

Entrées micro :
Impédance d'entrée : 
Alimentation fantôme : 
Gain maximum : 
Bruit (gain max) :
 
Niveau d'entrée maximum :
Réponse en fréquence : 
DHT + bruit : 
  

Entrées ligne :  
Impédance d'entrée :  
Niveau d'entrée maximum : 
Réponse en fréquence : 
DHT + bruit :  
  
Entrées Instrument :  
Impédance d'entrée :  
Niveau d'entrée maximum :  
Réponse en fréquence :  
DHT + bruit :   

Sorties ligne :  
Niveau :  
Impédance :  

Sortie casque :  

Interface MIDI :  
Fréq. d'échantillonnage :  

Plage dynamique : 
  
  

Alimentation :   
 

Dimensions :
Poids :

XLR femelle (broche 2 = point chaud )
3 kΩ symétrique
48 Volts
+58 dB
−125 dBu avec gain type de 58 dB (source de 150 Ω)
−129 dBu avec gain type de 58 dB et pondération A (source de 150 Ω)
+21 dBu à gain minimum
+0/−1 dB, 20 Hz - 20 kHz
<0,006 %, 20 Hz - 20 kHz (entre entrée mic et sortie Main) 0 dBu en entrée
<0,003 %, 1 kHz, niveau d'entrée de -6 dBu

Jack stéréo 6,35 mm symétrique ou asymétrique
20 kΩ symétrique, 13 kΩ asymétrique
+32 dBu
+0/−1,5 dB, 20 Hz - 20 kHz (référence de 1 kHz)
<0,004 %, 20 Hz - 20 kHz (line input to main output) 0 dBu en entrée

Jack mono 6,35 mm asymétrique
1 MΩ
+13 dBu
+0/−2 dB, 20 Hz - 20 kHz (entre entrée instrument et sortie Main)
<0,004 %, 20 Hz - 20 kHz, 0 dBu en entrée

Jack stéréo 6,35 mm symétrique ou asymétrique
>+18 dBu maximum
32 Ω symétrique, 16 Ω asymétrique

Jack stéréo 6,35 mm, 350mW par canal dans 50 Ω 

Connecteurs MIDI In et Out DIN à 5 broches (signal de 5 Volts)
44,1, 48, 88,2, ou 96 kHz (définie par l'application logicielle) 

A/N (24 Bits) 105 dB type, mesure pondérée A, 20 Hz - 20 kHz 
(fréquence d'échantillonnage de 44,1 kHz)
N/A (24 Bits) 107 dB type, mesure pondérée A, 20 Hz - 20 kHz 
A/N/A (24 Bits) 102 dB type, mesure pondérée A, 20 Hz - 20 kHz 

12 W 9 Vca
Adaptateurs secteur disponibles : 
US et Canada : 120 Vca, 60 Hz  Adaptateur :  PS0913B - 120
Japon : 100 Vca, 50/60 Hz  Adaptateur :  PS0913B - 100
Europe : 230 Vca, 50 Hz  Adaptateur :  PS0913B - 230
Royaume Uni : 240 Vca, 50 Hz  Adaptateur :  PS0913B - 240
Australie : 240 Vca, 50 Hz Adaptateur : PS0913B - 240-AU

30,5 cm (l) x 10 cm (h) x 9,5 (p)
1 kg
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